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Introduction 
 

AePlus (Application Engine Workbench with Interactive Debugger) is a 

productivity tool that provides developers with a user friendly front-end 

through which they can run, test and debug AppEngine programs more 

efficiently thereby cutting down development effort and time. This results in 

time saving as well as improved quality outcome. 

 

AePlus Terminologies 
 

PSoft User: User name that will be used to Logon PeopleSoft 

application. e.g. PS, VP1 etc. 

Source Database: PeopleSoft Database name where AppEngine Source 

resides. e.g. HR90DEV, HR90INT etc 

Target Database: PeopleSoft Database name where AppEngine Runs e.g. 

HR90DEV, HR90INT etc. Generally it is same as Source 

Database but you can choose it to be different in that case 

AppEngine runs in Target database picking source code 

from Source Database. Source and Target Databases should 

have same Tools version. 

AE Name: Application Engine Program Name. 

AE Descr: Application Engine Program Description. 

AePlus User Name: User name registered with SqrPlus/PsPlus. This is same as 

LanId that you use to logon to Windows.  

AePlus User ID: PeopleSoft is a multi-user/multi-process system. To avoid 

any conflicts with other AePlus User running/debugging 

AppEngine programs, AePlus uses an unique identifier 

called AePlus User ID. This is constructed from Serial 

Number allocated to AePlus User Name. For example for 

User NeilS in the screen below, User ID is U002. 
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All PeopleSoft objects that relate to AePlus start with PP_XXX. These objects are 

integral part of AePlus. These objects are installed automatically except for the 

followings: 

 

SlNo Component Remarks 

1 Project: PP_AEPLS  

 
This project is available under aeplus folder. 
 
This should be imported in PeopleSoft Target Database if you would 
like to run AppEngine thru Process Scheduler. (i.e. Run Thru 
ProcSched checkbox is ticked). 
 
This project contains PP_SCHD_AE AppEngine that is used by 
AePlus to Schedule AppEngine program in Target Database. 
 

2 Project: PP_DEMO 

 
This project is available under aeplus folder. 
 
This should be imported in PeopleSoft Source Database if you would 
like to evaluate AePlus using supplied Demo AppEngine programs. 
Project does not contain Process Definition for PP_DEMO 
AppEngine program. 
 

3 
Process Definition: 
PP_Unnn_A00 
 

 
This is required if you would like to run AppEngine thru Process 
Scheduler and : 
 

 In Debug mode Or 

 In Target database that is different to Source database 
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Create process definition for Application Engine PP_Unnn_A00 
where Unnn is your AePlus User ID. For Example PP_U002_A00 if 
you are the second SqrPlus/AePlus user.  
 
Please see User Maintenance screen under SqrPlus User 
Administration for the number that has been allotted to you.  
 

4 Server Agent 

 
This is required if you would like to run AppEngine thru Process 
Scheduler and in Debug mode.   
 

Please see ‘Installing Server Agent’ for further details. 
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Process Definition Setup 
 

When AePlus  runs AppEngine program in debug mode or when Source Database is different to Target 

Database and run location is not client, there must be a process definition for AppEngine program 

PP_Unnn_A00 where Unnn is AePlus User ID. AePlus uses this program name as placeholder. This also 

ensures that there is no conflict when two AppEngine programs are run at the same time by different 

PeopleSoft user. 

 

Screen captures below show how this Process Definition should be created in PeopleSoft when AePlus 

User ID is U005. 
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SRI Technologies                                                                                Web Site: http://www.sritech.com.au 

 

 

run_debug_app_engine_using_aeplus                                                                                       Page 8 of 37 

 

  
 

 

Other tabs may have defaults values Click Save Button to save the Process Definition for AppEngine 

Program Name PP_U005_A00. This definition is only for AePlus user who has been setup as fifth user 

under SqrPlus/PsPlus. Each AePlus user should have their own PP_U005_A00 process definition setup. 
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AePlus Tutorial 
 

This section describes a step-by-step tutorial for using AePlus. 

 

Setup/Installation Check 

 

AePlus uses PeopleTools product as it is. Before you start using AePlus you must 

make sure that the AppEngine program (psae.exe) has been setup/installed 

properly on your PC. This is done as part of PeopleTools setup/install on your PC.  

 

Invoke AePlus Workbench. This program (aewb.exe) is located in your Server 

directory (e.g. P:\sritech). You may invoke this through AePlus Workbench 

shortcut (created while installing SqrPlus/PsPlus client) on your Desktop. This 

will put you in the following AePlus Workbench screen. The screen supports on-

line help.  
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In addition, PeopleSoft options (Options->PeopleSoft Options) should be setup 

correctly. This screen mainly defines setup related to PeopleSoft like PS_HOME, 

Database type etc. Please see the screen below: 

 

 

 

PS_HOME  should be left as blank that takes the value of  PS_HOME  as defind 

at AePlus installation time. Different value like p:\pt843 may be specified if you 

would like to use different Tools Version for time being. 

 

PSTOOLS_VERSION  should also be specified in n.nn format ignoring other 

characters like Tools Release 8.45.10  may be entered as 8.45. 

 

Enter your preferred source code editor. This is available under Options->General 

Options. Default value of „System Editor‟ is notepad. 
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Java Api’s: AePlus uses few java api‟s while it runs AppEngine in debug mode. 

These Api‟s are: 

 

 &javafile = CreateJavaObject("java.io.File", &FileName) 

 &JavaThread = CreateJavaObject("java.lang.Thread") 

 

It is important that these api‟s call work without any errors. If you find any error 

message while calling these api‟s, this would imply that PeopleTools installation 

is not properly done and some java components are missing. By default, when 

PeopleTools is installaed, java components are automatically installed. Supplied 

demo program PP_DEMO has included above java api‟s calls to ensure that your 

PeopleTools installation is proper. For example, if PeopleTools installation is 

proper, you should be able to run demo AppEngine program PP_DEMO as 

Normal without any errors. 

 

If Java Api‟s fail to work as expected, AePlus uses Win Api‟s instead to cope 

with the situation. However this switchover is meaningful only if AppEngine runs 

under windows. 

 

 

Run Options: 

 

Depending on setup and installation, you can run an AppEngine in many ways. 

The table below explains various combinations along with the prerequisites: 

 

Run Location 
Run Option 
Tools Version 

Run Description Prerequisites 

Client:  
 
Run NOT Thru 
Process  
Scheduler 
 
Using Windows 
psae.exe 

A. Option-CNS 
8.1 and above 

Run Normal at Client in 
Source Database 

None 

B. Option-CNT 
8.1 and above 

Run Normal at Client in 
Target Database 

 
Objects/Tables used/referred by 
AppEngine program that is not part 
of AppEngine program definition 
must exist in Target Database. 
 

C. Option-CDS 
8.4 and above 

Run with Debug at Client 
in Source Database 

None 

D. Option-CDT 
8.4 and above 

Run with Debug at Client 
in Target Database 

 
Objects/Tables used/referred by 
AppEngine program that is not part 
of AppEngine program definition 
must exist in Target Database. 
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Server:  
 
Run Thru 
Process  
Scheduler 
 
Using Server 
psae 

E. Option-SNS 
8.4 and above 

Run Normal at Server in 
Source Database 

 

 PP_SCHD_AE AppEngine in 
Source Database. 

 Process Definition of Source 
AppEngine in Source Database. 

 

F. Option-SNT 
8.4 and above 

Run Normal at Server in 
Target Database 

 

 PP_SCHD_AE AppEngine in 
Target Database. 

 Process Definition for 
PP_Unnn_A00 AppEngine in 
Target Database where Unnn is 
AePlus User ID. 

 Objects/Tables used/referred by 
AppEngine program that is not 
part of AppEngine program 
definition must exist in Target 
Database. 

 

G. Option-SDS 
8.4 and above 

Run with Debug at Server 
in Source Database 

 

 PP_SCHD_AE AppEngine in 
Source Database. 

 Process Definition for 
PP_Unnn_A00 AppEngine in 
Source Database where Unnn is 
AePlus User ID. 

 Server Agent running on 
machine where Process 
Scheduler is running. 

 

H. Option-SDT 
8.4 and above 

Run with Debug at Server 
in Target Database 

 

 PP_SCHD_AE AppEngine in 
Target Database. 

 Process Definition for 
PP_Unnn_A00 AppEngine in 
Target Database where Unnn is 
AePlus User ID. 

 Objects/Tables used/referred by 
AppEngine program that is not 
part of AppEngine program 
definition must exist in Target 
Database. 

 Server Agent running on 
machine where Target Process 
Scheduler is running. 

 



 
SRI Technologies                                                                                Web Site: http://www.sritech.com.au 

 

 

run_debug_app_engine_using_aeplus                                                                                       Page 13 of 37 

 

Snapshot and Source Code Listing: 

 

In addition to running AppEngine program as normal or in debug mode, you can also: 

 

 Take a snapshot of AppEngine source code for Source Version Control  purpose. 

 

Snapshot creates DMS *.dat version of AppEngine program and DMS import 

script that should be stored in Source Version Control repository. This *.dat and 

*.dms script file can be used to restore AppEngine program from history. 
 

 Generate AppEngine Source Code listing for quick browsing and analysis. This 

provides text and html version of source code for quick analysis. 
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List Version 

 

List version looks something like: 

 
000001 Source DbName:    H88DMO 

000002 Psoft User:       PS 

000003 AePlus User ID:   U004 

000004 AePlus User Name: sritech 

000005 AE Name:          PP_DEMO 

000006 TimeStamp:        2010-08-30 21:40:07 

000007 AE Descr:         Demo AE program 

000008 AE Comments:      This is a demo AE program to demonstrate AppEngine Debugging features in GUI mode.  

000009   

000010   

000011   

000012 0001  :PP_DEMO.MAIN.GetAE_ID.Active.Get Current ApplId                                   

.GBL.default.1900-01-01. 

000013   0001:Step Comments-->   Get Current Appl-ID.  

000014   

000015   0000:  SQL                                                                               

000016   0001:    %Select(AE_APPLID) 

000017   0002:    SELECT %AEProgram 

000018   0003:    FROM PS_INSTALLATION 

000019   

000020 0002  :PP_DEMO.MAIN.START.Active.Common Start Actions                      .GBL.default.1900-01-01. 

000021   0000:  Call Section PP_AE_LIB.PP_START                                                   

000022   

000023 0003  :PP_DEMO.MAIN.ReadRC.Active.Read Run Control                         .GBL.default.1900-01-01. 

000024   0000:  SQL                                                                               

000025   0001:    %Select(ASOFDATE, FLAG1, FLAG2) 

000026   0002:    SELECT %DateOut(ASOFDATE) , FLAG1 , FLAG2 

000027   0003:    FROM PS_PP_DEMO_RC 

000028   0004:    WHERE OPRID = %Bind(OPRID) AND 

000029   0005:          RUN_CNTL_ID = %Bind(RUN_CNTL_ID) 

000030   

000031 0004  :PP_DEMO.MAIN.SetRC.Active.Set Defaults in RC if not foun           .GBL.default.1900-01-01. 

000032   0001:Step Comments   Set RunControl.  

000033   

000034   0000:  PeopleCode                                                                        

000035   0001:    Declare Function ToLog PeopleCode PP_DEMO_LIB.AE_PROGRAM FieldFormula; 

000036   0002:     

000037   0003:    Global number &gbl_menu_items; 

000038   0004:    Global number &gbl_Navig_items; 

000039   0005:     

000040   0006:    ToLog("", "AET OPRID: " | PP_DEMO_AET.OPRID); 

000041   0007:    ToLog("", "AET RUN_CNTL_ID: " | PP_DEMO_AET.RUN_CNTL_ID); 

000042   0008:     

000043   0009:    If None(PP_DEMO_AET.ASOFDATE) Then 

000044   0010:       /* RC table is not populated */ 

000045   0011:       ToLog("", "RC Not Populated, Setting Defaults RC Values."); 

000046   0012:       PP_DEMO_AET.ASOFDATE = %Date; 

000047   0013:       PP_DEMO_AET.FLAG1 = "Y"; 

000048   0014:       PP_DEMO_AET.FLAG2 = "Y"; 

000049   0015:    End-If; 

… 

… 

… 

… 

000347 0011  :PP_DEMO.PP_MENU.Step02.Active.Step02 description                  .GBL.default.1951-01-01. 

000348   0000:  PeopleCode                                                                        

000349   0001:    Declare Function ToLog PeopleCode PP_DEMO_LIB.AE_PROGRAM FieldFormula; 

000350   0002:    Global number &gbl_menu_items; 

000351   0003:     

000352   0004:    ToLog("", "Total Menu Items Listed: " | &gbl_menu_items); 

000353   0005:     

000354   

000355   

000356 0012  :PP_DEMO.PP_NAVIG.Step01.Active.Step01 description                 .GBL.default.1900-01-01. 

000357   0000:  PeopleCode                                                                        

000358   0001:    Declare Function ToLog PeopleCode PP_DEMO_LIB.AE_PROGRAM FieldFormula; 

000359   0002:     

000360   0003:    ToLog("", "Navigations yet to be processed"); 

000361   0004:     

000362   0005:    &INFO = GetRecord(@("RECORD." | "PP_DEMO_AET")); 

000363   0006:    &MYFLD = &INFO.GetField(@("FIELD." | "OPRID")); 

000364   0007:     

000365   0008:    &tmp = &MYFLD.value; 

000366   0009:    ToLog("", "OprId Value: " | &tmp); 

000367   0010:     

000368   0011:    rem last line; 

000369   0012:     

000370   

000371 ** End Of Source Code ** 

000372       

000373     ** Declared Global/Component Generic Data Type Variables 

000374       
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000375        Slno   Scope        Type         Variable                       Dimension Line Reference 

000376        ----   ------------ ------------ ------------------------------ --------- -------------- 

000377       

000378        0001   component    number       &com_var_num                             94 

000379        0002   component    string       &com_var_str                             95 

000380        0003   global       number       &gbl_menu_items                          37,336,350 

000381        0004   global       number       &gbl_navig_items                         38 

000382        0005   global       boolean      &gbl_var_bool                            90 

000383        0006   global       date         &gbl_var_date                            88 

000384        0007   global       datetime     &gbl_var_datetime                        89 

000385        0008   global       float        &gbl_var_float                           91 

000386        0009   global       integer      &gbl_var_integer                         92 

000387        0010   global       number       &gbl_var_num                             86 

000388        0011   global       string       &gbl_var_str                             87,96 

000389        0012   global       time         &gbl_var_time                            93 

000390       

000391     ** Declared Global/Component Generic Data type Arrays 

000392       

000393        Slno   Scope        Type         Variable                       Dimension Line Reference 

000394        ----   ------------ ------------ ------------------------------ --------- -------------- 

000395       

000396        0001   component    number       &com_arr_num                   2         106 

000397        0002   component    string       &com_arr_str                   2         107 

000398        0003   global       boolean      &gbl_arr_bool                  1         102 

000399        0004   global       date         &gbl_arr_date                  2         100 

000400        0005   global       datetime     &gbl_arr_datetime              2         101 

000401        0006   global       float        &gbl_arr_float                 2         103 

000402        0007   global       integer      &gbl_arr_integer               2         104 

000403        0008   global       number       &gbl_arr_num                   2         98 

000404        0009   global       string       &gbl_arr_str                   2         99 

000405        0010   global       time         &gbl_arr_time                  2         105 

000406       

000407     ** Declared Global/Component Record Variables 

000408       

000409        Slno   Scope        Type         Variable                       Dimension Line Reference 

000410        ----   ------------ ------------ ------------------------------ --------- -------------- 

000411       

000412        0001   global       record       &flddefn                                 111 

000413        0002   global       record       &recdefn                                 110 

000414       

000415     ** Declared Global/Component Field Variables 

000416       

000417        Slno   Scope        Type         Variable                       Dimension Line Reference 

000418        ----   ------------ ------------ ------------------------------ --------- -------------- 

000419       

000420        0001   global       field        &flddescr                                113 

000421        0002   global       field        &recdescr                                112 

000422       

000423       

000424     ** End Of Listing ** 

000425       
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HTML Version 

 

Html version looks something like: 
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Running AppEngine Program 
 

AppEngine can be run in many ways. This section describes various Run 

Options. 
 

A. Run Option-CNS : Run Normal at Client in Source Database 

 

Enter AppEngine Name, Database, Username and Password etc as shown in 

the screen below: 

 

 

 
 

 Keep „Run Location‟ as Client. This means that AePlus will use your 

psae.exe located under PS_HOME to run AppEngine programs. Enter 

„App Engine Program:‟ as „PP_DEMO‟. This is supplied demo 

program that should be loaded into Source Database by importing 

supplied project PP_DEMO. Alternatively, you can enter any App 

Engine program that you would like to run thru AePlus Workbench. 

 This will update the „Ae Log File‟ text box with the default value. 
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 Tick „Same as Source‟ Check box as we would like to run this 

AppEngine in Source Database itself. 

 Enter Source DbName, PeopleSoft User and PeopleSoft Password. For 

example: H88DMO, PS and password for PeopleSoft User PS. 

 Enter „Run Control Id‟ that this AppEngine will use. 

 Process Instance can be left as 0. 

 Enter „Additional Cmd Line Args‟ that you would like to have for this 

AppEngine. For example, -TRACE 123 can be used to produce *.AET 

file with trace. 

 Click „Run Normal‟ to run this AppEngine in source database.  

 

 

The specified AppEngine will run and produce the AE Log file like: 

D:\temp\PP_DEMO.log. Click „View Log File‟ to verify results in log file. 

 

If any errors are reported (PeopleTools/Windows related or anything else), or you 

did not get the log file, the problem needs to be FIXED before proceeding further. 

 

AePlus log may be referred (by clicking „View AePlus Log‟) to  analyze the 

issue. It may be due to psae.exe or psdmt.exe not able to complete successfully. 

This log file shows what command was issue like: 

 
2010-08-18 23:22:37    Exporting AE Definition PP_DEMO from H88DMO 

2010-08-1823:22:37    Executing Command: F:\pt845\bin\client\winx86\psdmt.exe -CT 

MICROSFT -CD H88DMO -CO PS -CP <Password> -FP 

D:\temp\PP_U004_aedms_exp.dms 

 

 

AePlus uses psdmt.exe (Data Mover) program to extract AppEngine definition. 

This is launched Synchronously. If this fails to launch due to insufficient 

windows resources, AePlus will continue to wait. To terminate this wait, use 

„cancel Active/Synchronously wait‟ that can be invoked from: 

 

AePlus Workbench->File-> Cancel Active/Synchronous Wait 

 

Try again after freeing some Windows resources. 
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B. Option-CNT : Run Normal at Client in Target Database 

 

Enter AppEngine Name, Database, Username and Password etc as shown in 

the screen below: 

 

 
 

 

 Uncheck „Same as Source‟ Check box as we would like to run this 

AppEngine in different Database (Different to Source Database). 

 Enter Target DbName, PeopleSoft User and PeopleSoft Password. For 

example: H88INT, PS and password for PeopleSoft User PS. 

 Click „Run Normal‟ to run this AppEngine in Target Database. 

 

This will get AppEngine definition from source database. Compiles it as 

PP_Unnn_A00 AppEngine program in Target Database where Unnn 

AePlus_User ID. Runs newly compiled program in Target database.  
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It is important that each AePlus User ID is unique so that two users who may 

share same PeopleSoft Username (Like PS) have their own version of AppEngine 

program (PP_Unnn_A00) in Target database. PP_Unnn_A00  is just a 

placeholder for AppEngine program that is used for various AePlus activities like 

running AppEngine program in different database or running it in Debug mode.  

 

The compiled version of AppEngine holds objects (Sections/Steps/Actions) 

specific to Source AppEngine program only (i.e. all other objects and data are 

used from Target database). These objects are used to run AppEngine program in 

Target Database using the application data of Target database. With this 

flexibility, you can run AppEngine program in different database without 

changing/migrating AppEngine program in target database but utilizing Target 

database application data set that is hard to simulate in Source database to address 

particular business data scenario. Compiled version of AppEngine uses/refers all 

other objects from Target database. 
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C. Run Option-CDS : Run with Debug at Client in Source Database 
 

Although you can run any AppEngine program in debug mode but for 

demonstration purpose supplied demo program PP_DEMO  has been used. This 

can be loaded into source database by importing PP_DEMO project located in 

aeplus folder under „Server Directory‟ (e.g. p:\sritech\aeplus).  

 

This is a small comprehensive  AppEngine program that uses: 

 

 State Record PP_DEMO_AET 

 Derived Record PP_DEMO_LIB for some FuncLib PeopleCode 

 Run Control Record PP_DEMO_RC 

 AppEngine Library PP_AE_LIB 

 AppEngine SQL 

 Comprehensive PeopleCode 
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Enter AppEngine Name, Database, Username and Password etc as shown in 

the screen below: 

 

 
 

 Since AppEngine program will run in debug mode at client, Select „Server 

Agent‟ as Client and Un-Check „Run Thru ProcSched‟ checkbox. 

 Enter PP_DEMO  as „App Engine Program‟ 

 Check „Same as Source‟ Check box as we would like to run this 

AppEngine in Source Database. 

 Enter Source DbName, PeopleSoft User and PeopleSoft Password. For 

example: H88DMO, PS and password for PeopleSoft User PS. 

 „Addl Cmd Line Args‟ can be left as blank. 

 Run Control Id can be left as blank. 

 Process Instance can be left as 0 

 Click „Run With Debug‟ to run this AppEngine in Source Database with 

Debug. 
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AePlus goes thru the compilation process that is logged in AePlus log file 

(Unnn_AePlus.log in AePlus Temp folder. e.g. c:\temp\U001_AePlus.log). If 

compilation is successful you will get into following screen for interactive debug 

session with your AppEngine program.  
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In above screen the demo program PP_DEMO is running in Database 

H88DMO in debug mode and ready to execute first Step of the Main section 

while waiting for the user input. At any point while program is waiting for 

user input, a debug command can be used. List of debug commands are 

available under Menu Item „Debug‟ 
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The screen is divided into three windows as: 

 

 Display window will be blank at this stage. Later on, this window will be 

used to display the results of various AePlus debug commands. 

 

 Command window will also be blank at this stage. The left column shows 

the serial number and will be 1 at this stage. 

 

 Source and Display windows are „Read Only‟ windows. Command 

window provides the area where you will enter various AePlus debug 

commands. 

 

 

Current line that will be executed is shown as: 

 

 

which will execute SQL: 

 

0001:    %Select(AE_APPLID) 

0002:    SELECT %AEProgram 

0003:    FROM PS_INSTALLATION 

 

„*‟ after the line number indicates that it is a valid source line where break point 

can be set. 

 

Enter F8 (or enter step in command window followed by „Enter‟ key) 

 

 

 

This will execute SQL at step 0001 and cursor will move to Step 0002 as 

shown below: 
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Double click at line number 32 to set a break point. 
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This will set a break point at step 0004 along with command confirmation in  

Display window: 

 

 
 

 

Press F5 or enter go in the command window. This will execute Step 0002 thru 0003 

and cursor will move to line 32 as shown below: 

 

 

 

Pressing F8 (step) will execute step 0004 and cursor will move to next step. 

However, we would like to step thru each line of PeopleCode and so we will 

press Shift+F8 (step/into) this time. This will take us to the first executable 

PeopleCode like e.g. line 00041 as shown below: 
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While program is waiting for user input, any debug command can be issued. 

At this stage we can see value of State Record or value of global variable. 

Also, we can choose to modify value of State Record Field or global variable 

to impact change in program flow. Let us see what is the value of 

PP_DEMO_AET.OPRID at this stage by issuing debug command: 

 

Command: esf PP_DEMO_AET.* displays value of all the field in State 

Record PP_DEMO_AET where as command PP_DEMO_AET.OPRID 

displays value of OPRID only as shown in the screen below: 

 



 
SRI Technologies                                                                                Web Site: http://www.sritech.com.au 

 

 

run_debug_app_engine_using_aeplus                                                                                       Page 29 of 37 

 

 

 

Let us set another break point at line number 00053.  
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Let us see all the active break points at this stage by issuing debug command: 

lb (list break) 

 

 

 

Pressing F5 (go) will take us to line number 00053. We can execute each line 

of PeopleCode using F8 (step) command and examine result using various 

debug commands. 

 

Screen below shows the ability to examine value of global variable by just 

positioning the mouse on the variable in source window: 

 

 

In addition to function keys, command window is used to enter various 

debug commands. Each debug command is terminated by ‘Enter’ key. The 

Arrow keys may be used to pickup commands from the history. It is the 

‘Enter’ key that completes the debug command. 

 

Ones AppEngine completes successfully, you can exit the debug mode by 

clicking „Exit Debug Mode‟ command button or enter Exit command in 

command window. 
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This will close the debug window and workbench window will be restored. 
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When running program in debug mode, if AppEngine calls Sections Dynamically, 

value of state record should be changed just in time so that appropriate sections 

are called at run time. For Example, when debugging TL_TIMEADMIN program 

that calls section from TL_TA_RULES AppEngine dynamically, value of  AE 

Program name should be modified in State Record by appropriate PP_Unnn_Axx 

just before the Section Call where PP_Unnn_Axx is the Ae Name assigned to  

TL_TA_RULES by AePlus compiler. This can be achieved by setting break point 

before the Call Section Step.  

 

PP_Unnn_Axx value can be obtained from “Object Mapping” table in *.lst file 

that is created by AePlus in SqrPlus temp directory.  This will be something like: 

 
 

…. 

000560     Object Mapping 

000561       

000562            Original Object                     Mapped Object   

000563            ----------------------------------- ----------------------------------- 

000564            TL_TIMEADMIN                PP_U004_A00 

000565            TL_TA000410                       PP_U004_A01 

000565            TL_TA000800                       PP_U004_A02 

000565            TL_TA_RULES                    PP_U004_A03 

000567       

…. 

…. 
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D. Run Option-CDT : Run with Debug at Client in Target Database 
 

This is same as Run Option C (Run With Debug at Client in Source 

Database) except that and Source Database and Target Database are different. 

Debug version of AppEngine runs in Target Database instead of Source 

Database. The compilation process takes AppEngine definition from Source 

Database but compiled version  is created in Target Database.  

 

E. Run Option-SNS : Run Normal at Server in Source Database 

 

This is same as Run Option A (Run Normal at Client in Source Database) 

except that the AppEngine is run thru Process Scheduler. AePlus uses 

PP_SCHD_AE AppEngine program to schedule AppEngine program in 

Source Database.  

 

Run Thru ProcSched checkbox should be ticked. Server Name should be 

specified although that may be overridden by appropriate Server name when 

process is scheduled. e.g. PSNT may change to PSUNX when process is 

scheduled. 

 

AePlus Workbench notifies developer when AppEngine completes. However, 

log files created by the AppEngine program should be viewed thru Process 

Monitor. It is essential that AppEngine program specified has the Process 

Definition setup in source database. 
 

F. Run Option-SNT : Run Normal at Server in Target Database 
 

This is same as Run Option B (Run Normal at Client in Target Database) 

except that the AppEngine is run thru Process Scheduler. AePlus uses 

PP_SCHD_AE AppEngine program to schedule compiled AppEngine 

program (PP_Unnn_A00) in Target Database.  

 

Run Thru ProcSched checkbox should be ticked. Server Name should be 

specified although that may be overridden by appropriate Server name when 

process is scheduled. e.g. PSNT may change to PSUNX when process is 

scheduled. 

 

AePlus Workbench notifies developer when AppEngine completes. However, 

log files created by the AppEngine program should be viewed thru Process 

Monitor. It is essential that AppEngine PP_Unnn_A00 has the Process 

Definition setup in target database where Unnn is AePlus User ID. 
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G. Run Option-SDS : Run with Debug at Server in Source Database 
 

This is same as Run Option C (Run with Debug at Client in Source 

Database) except that the AppEngine  runs thru Process Scheduler. AePlus 

uses PP_SCHD_AE AppEngine program to schedule compiled AppEngine 

program (PP_Unnn_A00) in Source Database.  

 

Run Thru ProcSched checkbox should be ticked. Server Name should be 

specified although that may be overridden by appropriate Server name when 

process is scheduled. e.g. PSNT may change to PSUNX when process is 

scheduled. 

 

Debugging interface is same as that in Run Option C. However, since 

AppEngine runs is a different machine, Server Agent must be up and running 

on machine where AppEngine runs.  Server Agent should also point to correct 

Remote Server Agent (other than Client). For further details on „Remote 

Server Agent‟, please refer to Installing Server Agent topic. 

 

It is also essential that AppEngine PP_Unnn_A00 has the Process Definition 

setup in source database where Unnn is AePlus User ID. 

 
 

H. Run Option-SDT : Run with Debug at Server in Target Database 
 

This is same as Run Option D (Run with Debug at Client in Target Database) 

except that the AppEngine runs thru Process Scheduler. AePlus uses 

PP_SCHD_AE AppEngine program to schedule compiled AppEngine 

program (PP_Unnn_A00) in Source Database.  

 

Run Thru ProcSched checkbox should be ticked. Server Name should be 

specified although that may be overridden by appropriate Server name when 

process is scheduled. e.g. PSNT may change to PSUNX when process is 

scheduled. 

 

Debugging interface is same as that in Run Option D. However, since 

AppEngine runs is a different machine, Server Agent must be up and running 

on machine where AppEngine runs.  Server Agent should also point to correct 

Remote Server Agent (other than Client). For further details on „Remote 

Server Agent‟, please refer to Installing Server Agent topic. 

 

It is also essential that AppEngine PP_Unnn_A00 has the Process Definition 

setup in target database where Unnn is AePlus User ID. 
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Ae Abends 
 

Whenever an AppEngine that runs at Client (i.e. not thru Process Scheduler) and it 

abends due to some run time errors, you may have to manage this abended process so that 

you are able to run this process next time. Screen capture below shows how to manage 

such un-finished process. 

 

Navigation: PeopleTools->Application Engine->Manage Abends 

 

 

 

If AppEngine that runs at Server thru Process Scheduler, it should be managed thru 

Process Monitor. 
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Source Version Control AppEngine using AePlus  
 

Source Version Control is an essential part of any Source Code in any software 

development environment. With AePlus you can Source Version Control AppEngine 

source code using the same Source Version Control Software that you use for SQRs or 

COBOLs. AppEngine source code is kept as one unit. Since Source code can be 

preserved in Source Version Control software - you always know where the master copy 

is and never lose your coding effort as a result of database refresh. You can easily 

compare two versions of AppEngine source code (that is available in text format) to find 

what exactly has changed. Rolling back to previous version is much controlled and 

quality assured. 

 
 

 

 

Following steps are required: 

 

 Enter AppEngine program name that you would like to put into Source 

Version Control Software. 

 Enter Source Database, Username and Password. 

 Click Utility->Create AE Snapshot 

 

This will extract AppEngine Definition from Source Database and produce 

followings: 

 

 AppEngine Source Code in text format. For example if AppEngine 

program name is PP_DEMO and Source Database is H88DMP, text 

snapshot will be created as  c:\sqrplus\ae\PP_DEMO_H88DMO.txt 

where c:\sqrplus\ae is AE_SNAPSHOT_DIR as defined in AePlus 

Options. This text file should be checked into your Source Version 

Control repository to facilitate general browsing and comparision 

between two versions. 
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 In addition, Dat and Dms files are also created to facilitate rollback to 

specific version when needed. For example for PP_DEMO AppEngine 

program, c:\sqrplus\ae\PP_DEMO_imp.dat and c:\sqrplus\ae\ 

PP_DEMO_imp.dms are created. 
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